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Safety Notice

Read all product manuals and consult with Beckman Coulter-trained personnel before attempting 
to operate instrument. Do not attempt to perform any procedure before carefully reading all 
instructions. Always follow product labeling and manufacturer’s recommendations. If in doubt as 
to how to proceed in any situation, contact your Beckman Coulter Representative.

Alerts for Warning, Caution, Important, and Note

WARNING

WARNING indicates a potentially hazardous situation which, if not avoided, could 

result in death or serious injury.

CAUTION

CAUTION indicates a potentially hazardous situation, which, if not avoided, may 

result in minor or moderate injury. It may also be used to alert against unsafe 

practices.

IMPORTANT IMPORTANT is used for comments that add value to the step or procedure being performed. 

Following the advice in the Important adds benefit to the performance of a piece of equipment or to a 

process.

NOTE NOTE is used to call attention to notable information that should be followed during installation, use, 

or servicing of this equipment.
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Introduction
Intended Use

The product is not intended or validated for use in the diagnosis of disease or other conditions.

Overview

This introductory section contains the following topics:

 • How to Use This Manual 

 • About This Manual

How to Use This Manual

Use this manual to configure, test and operate the RNAdvance Blood method. It contains 
information on: 

 • Instrument Requirements

 • System Configuration Settings

 • Method Operation

About This Manual

NOTE Screens in this manual may differ slightly from the screens in your RNAdvance Blood method.

The information in this Instructions for Use manual is organized as follows:

Chapter 1, Instrument Requirements

Contains deck configuration and general settings for operating the RNAdvance Blood method.

Chapter 2, Method Operation

Contains the settings and procedures for operating the RNAdvance Blood method.

The manual also includes a List of Abbreviations, a Glossary, and an Index.
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About This Manual  
Conventions

 • Selections that appear on a screen are in bold face.

 • Information that is to be typed (entered) is in bold face and italics font.

 • The software path to a specific function or screen appears with the greater than ( > ) symbol 
between succeeding screen options, like this: Select Control Panel > Network and Sharing.

 • Links to information in another part of the document for additional information are in blue. 
To access the linked information, select the blue text.
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CHAPTER 1

Instrument Requirements
Instrument Requirements

Biomek 4000 with software version 4.1 or higher. Contact your Beckman Coulter Representative for 
the Method CD for your platform, call 1-800-369-0333, or email reagentsupport@beckman.com if 
your sales contact information is unknown.

Deck Configuration

See Figure 1.1 for the recommended deck layout.

Figure 1.1  Recommended Deck Layout

Table 1.1  Requirements for RNAdvance Blood Method

Type Qty Description Part number

Tools 1 Gripper Tool 987371

1 MP200 Eight-Tip Pipette Tool 986146

1 MP1000 Eight-Tip Pipette Tool A91112
B39494AA 1-1



Instrument Requirements

Instrument Requirements  
ALPs 1 Liquid Waste ALP B21398

1 Disposal ALP 609751

5 Labware Holder 609120

4 Tip Rack Holder 391910

1 Static Peltier Device A93938

1 Orbital Shaker 379448

1 Peltier Adaptor Plate (96 well round 

bottom)

A49568

1 Off Deck Tool Rack Kit (left) B21395

Magnet Plate 1 Super Magnet Plate A32782

Reservoirs 2 Reservoir Frame 372795

2 Half Reservoir 372786

3 Quarter Reservoir 372790

1 IMReservoir96 (Fisher Scientific) 50-995-860

1 Quarter Reservoir (divided by length) 372788

Consumables 3 Biomek Span-8 P1000 Tips, Pre-Sterile 

with Barrier

B01124

1 Biomek AP96 P250 Tips, Pre-Sterile with 

Barrier

717253

1 96 Well PCR Platea AB-2800

1 RK Riplate Deepwell Plate (Worldwide 

Medical)

99181000

a. ABGene 2800 or equivalent.

Table 1.1  Requirements for RNAdvance Blood Method

Type Qty Description Part number
B39494AA1-2
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System Configuration Settings

Customer Default Settings

The system configuration settings section contains additional selections. Adjust the following fields 
as needed.

To adjust user defaults and settings

1 Open the Biomek Software.

2 Open the RNAdvance Blood method by clicking File > Open. The method opens and the method 

outline displays. See Figure 1.2.

Figure 1.2  Configure Method Outline

3 From the method outline click User Defaults and Settings. See Figure 1.2. The screen in 

Figure 1.3 displays.
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Figure 1.3  RNAdvance Blood Customer Default Values
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NOTE It is recommended that you save the new version of the method under a different name to preserve 

the original. This allows you to go back to the original as a starting point if needed. 

IMPORTANT Changing default protocol settings may cause invalid method results. Beckman Coulter’s 

warranty applies only for unchanged Customer Default Protocol Settings.

To restore the Beckman Coulter Agencourt Default settings, click the Reset to Default Values Button.

IMPORTANT The Reset to Default Values button does not reset the Peltier temperature offsets. These 

offsets are determined during installation and are meant to ensure your samples reach the desired 

temperature during method execution. The actual Peltier temperature is equal to the sum of the set 

temperature, plus the offset temperature. The formula would be as follows:

Sample Temp + Peltier Temp Offset = Actual Peltier Temp

For example, to determine the actual temperature of the Peltier for Lysis:

If the Lysis Temperature is set to 55°C, and the Lysis Peltier Temperature Offset is set to 40°C, the actual 

temperature of the Peltier would be:

55°C + 40°C = 95°C

Table 1.2  RNAdvance Blood Customer Default Value Descriptions

Screen Element Purpose Do this

A  Default 

Protocol Settings

These values can be adjusted for customer 

specified processes. These values will feed 

into the application interface as the default 

values.

Change values as needed based on 

your specific protocol.

B  Reset to 

Default Values

Resets all values (except the Peltier Offset 

values), back to the factory default values.

Click the button to revert all values to 

the default values.

C  LIMS Folder File location to save Laboratory Information 

Management System (LIMS) data.

Enter the file path where you would 

like application data saved. For 

example: c:\Program Files\LIMS

D  Peltier Offsets During installation the Peltier Offset 

temperature values are determined based 

on the particular Peltier installed. Only 

change these values when recommended 

by Beckman Coulter.

Do not change.
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CHAPTER 2

Method Operation
Installation

Your Beckman Coulter Field Applications Scientist performs all Biomek and RNAdvance Blood 
Application installation and setup services. For service, see your Beckman Coulter Representative.

Operating the RNAdvance Blood Method

NOTE For more information about Agencourt RNAdvance Blood and the Agencourt RNAdvance Blood 

protocol, see www.beckmancoulter.com. The automated method has been optimized for automation and 

may differ from the manual protocol.

Starting the RNAdvance Blood Method and 

Establishing Default Protocol Settings

The RNAdvance Blood Method is shipped with a set of standard protocol values. But these values 
may need to be modified for your laboratory. These values populate the RNAdvance Blood method 
application. 

To open and start the method

1 Open the Biomek software.

2 Open the RNAdvance Blood Project by clicking Project > Open Project.
B39494AA 2-1
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Method Operation

Operating the RNAdvance Blood Method  
3 Open the RNAdvance Blood method by clicking File > Open. Select RNAdvanceMethod.

NOTE Your method structure may look larger and may not have + and – icons to expand and collapse 

the structure. To change the appearance of the method structure, click Options > Preferences and 

then click View in the menu bar on the left. Use this option to change the appearance of the method 

structure.

Figure 2.1  Method Outline

4 From the method outline, click User Defaults and Settings. See Figure 2.1. The User Defaults and 

Settings screen displays.

NOTE You can skip steps 4 and 5 if already configured previously.
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Figure 2.2  User Defaults and Settings, Top portion shown
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Operating the RNAdvance Blood Method  
Figure 2.3  Default GUI Values, Bottom portion shown

5 Change or ensure that each variable is the correct default value. These values can be changed 

at run time. For details on this screen see Table 1.2. 

IMPORTANT Changing default protocol settings may cause invalid method results. Beckman Coulter’s 

warranty applies only for unchanged Customer Default Protocol Settings.

To restore default settings, click the Reset to Default Values Button.
B39494AA2-4
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IMPORTANT The Reset to Default Values button does not reset the Peltier temperature offsets. These 

offsets are determined during installation and are meant to ensure your samples reach the desired 

temperature during method execution. The actual Peltier temperature is equal to the sum of the set 

temperature, plus the offset temperature. The formula would be as follows:

Sample Temp + Peltier Temp Offset = Actual Peltier Temp

For example, to determine the actual temperature of the Peltier for Lysis:

If the Lysis Temperature is set to 55°C, and the Lysis Peltier Temperature Offset is set to 40°C, the actual 

temperature of the Peltier would be:

55°C + 40°C = 95°C

6 From the Biomek software, click Execution > Run .

Configuring the RNAdvance Blood Method

The graphical user interface appears and allows you to make some selections. To achieve optimal 
performance for different sample types, you may need to adjust some selections.

The RNAdvance Blood Method contains a graphical user interface to ensure proper processing of 
samples. This interface contains four tabs, three of which step you through the setup process until 
the method is ready to run.

The four tabs include:

Quick Start — Use this Tab to configure the sample and finals plates, and to 

track reagent lot numbers. See the Quick Start Tab on page 2-6.

Columns — Use this Tab to define the number and location of active columns 

on the sample plates. See the Columns Tab on page 2-9.

Procedure — Use this Tab to configure the protocols. See the Procedure Tab on 

page 2-11.

Recovery — Use this Tab only if you need to restart the method and recover it 

at the point it was interrupted. See the Recovery Tab on page 2-18.
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Quick Start Tab

Figure 2.4  Quick Start Tab

A. Quick Start Tab

B. Input Values

C. Forward Button

D. Labware Selector

E. Output Values

F. Tracking

G. Deck Display

H. Run Button

I. Abort Button
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To complete the Quick Start Tab Run Settings

1 On the Quick Start Tab select the sample volume in �L.

2 Select whether to transfer the eluate to the final plate.

NOTE Most laboratories choose to transfer the eluate to a new plate.

Table 2.1  Describing the RNAdvance Blood Primary Screen

Screen Element Purpose Do this Notes

A  Quick Start 

Tab

Allows you to define the 

sample inputs, outputs 

and whether to track the 

method.

Complete all fields. N/A

B  Input Values Allows you to define the 

sample volume of the run.

Complete all fields. N/A

C  Forward 

Button

Allows you to advance to 

the next screen.

Click the button to advance. Use this button or just click the 

next tab.

D  Labware 

Selector

Allows you to determine 

the define the elution 

plate.

Select the desired elution plate type.

E  Output Values Allows you to define the 

elution and transfer 

volumes.

Select whether to transfer to a final 

plate and then select the correct 

elution and (if transferring) transfer 

volumes.

Most laboratories choose to 

transfer the eluate to a new 

plate.  

F  Tracking Allows you to track 

RNAdvance Blood 

reagents automatically by 

Lot numbers.

To track RNAdvance Blood reagents 

automatically, click Yes and record the 

User ID and the applicable lot numbers.

N/A

G  Deck Display Displays the correct deck 

setup based on your 

inputs.

Check the Deck Display against the 

Biomek 4000 Deck.

N/A

H Run Button Allows you to start running 

the method.

Click the Run button. This Button appears on all four 

tabs.

I  Abort Button Allows you to stop the 

method.

While the Application GUI is displayed, 

click this button to abort.

This Button appears on all four 

tabs.
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3 Click the Labware Selector. The Labware Selector screen displays. See Figure 2.5.

Figure 2.5  Labware Selector

4 Select the Elution Labware Plate Type used in your RNAdvance Method. Click OK.

5 If transferring, select the Elution and Transfer Volume in �L. The default volume that Beckman 

Coulter recommends is 40 �L.

6 Select the Transfer Volume in �L. The default volume that Beckman Coulter recommends is 

30 �L.

NOTE Beckman Coulter recommends a transfer volume of at least 10�L less than the elution volume to 

avoid any bead carryover.

7 Select whether the application should write a log file. If Yes, follow the steps below. 

If No, skip to step 8.

a. Enter the User ID.

b. Enter the RNAdvance Kit Lot #.

c. Enter the Elution Buffer Lot #.

d. Enter the Ethanol Lot #

e. Enter the Isopropanol Lot #.

f. Enter the DNase Lot #.

g. Enter the DNase Buffer Lot #.

h. Enter Notes if needed.

NOTE If this feature is used, the RNAdvance Blood application will record a log file to the computer folder 

defined on the Configure Method screen. See Customer Default Settings on page 1-3 for information 

on how to access this screen.
B39494AA2-8
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8 Click the Columns Tab or the  button. The Columns Tab Setup Screen is displayed.

Columns Tab

Figure 2.6  Columns Tab showing Sample Plate Selection

A. Columns Tab

B. Back Button

C. 96-Well Plate Column
B39494AA 2-9
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WARNING

Orbital shaker hazard. Distribute samples evenly across the plate to prevent the 

plate from becoming unbalanced. An unbalanced plate may propel hazardous 

substances from the orbital shaker. Refer to the Biomek 4000 ALPs and 

Accessories Manual for complete safety information.

To complete the Columns Tab

1 On the Columns Tab, select the active columns by clicking the appropriate 96-Well Plate Column 

Heading. To highlight all or none of the cells, click the top-left Well Plate Column Heading. 
This acts as a toggle.

2 Click the Procedure Tab or the  button. The Procedure Tab Setup Screen displays.

Table 2.2  Describing the Columns Screen

Screen Element Purpose Do this Notes

A  Columns Tab Allows you to define active 

columns.

Select columns in any order. Rows 

cannot be selected. 

Any combination of individual 

columns can be made active, 

but cells cannot be made 

active as rows or as individual 

wells.

B  Back Button Allows you to return to the 

previous tab.

Select this button to return to the Quick 

Start Tab.

N/A

C  96-Well Plate Allows you to visualize and 

select columns more 

easily.

Click on the heading buttons above the 

column to select and deselect columns 

to be run on the Biomek 4000.

Figure 2.6 shows all columns 

selected. Your application may 

be different.
B39494AA2-10
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Procedure Tab

Figure 2.7  Procedure Tab, Top portion shown

A. Procedure Tab

B. Lock/Unlock Button

C. Reset Default Values

D. Procedure Values
B39494AA 2-11
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The values for these steps originate from the Default Protocol Settings. You can access these 
settings from the User Defaults and Settings step. See Customer Default Settings on page 1-3.

Use this Tab to customize the automated protocol at runtime. Most RNAdvance Blood variables can 
be adjusted. All protocol settings are written to memory when the run starts and recalled for 
subsequent runs.

Table 2.4 lists all automated method steps and the default, minimum and maximum values.

Table 2.3  Describing the Procedures Screen 

Screen Element Purpose Do this Notes

A  Procedure Tab Allows you to define and 

confirm all values in the 

RNAdvance Blood method.

Select all correct values. Changed 

values are highlighted in yellow.

The starting values are 

determined by the User 

Default and Settings step. See 

Customer Default Settings on 

page 1-3.

B  Lock/Unlock 

Indicator

Indicates whether the 

method protocol inputs are 

locked with a password.

To lock the protocol values, click the 

lock tab and enter a password.

Only the values on the 

Procedures Tab are locked.

C  Reset Default 

Values

Returns all values to the 

defaults established in the 

User Defaults and Settings 

step. See Customer 

Default Settings on page 

1-3. 

Click this button to return all values to 

the default values.

All manual entries will be lost 

without recourse.

D  Procedure 

Values

Allows you to change 

values in the 

RNAdvance Blood method.

Select the correct procedure values. 

Changed values are highlighted in 

yellow.

For a list of all procedure value 

defaults, minimums and 

maximums, see Table 2.4.

Table 2.4  Procedure Default, Minimum and Maximum Values

Step Step Description Units Default Minimum Maximum

Lysis

1 Lysis Volume �L 300 100 500

2 Proteinase K Solution Volume �L 40 20 100

3 Lysis Shake speed on the Orbital Shaker RPM 1200 1000 1200

Lysis Shake time minutes 3 1 60

4 Lysis Sample temperaturea �C 55 20 100

Lysis Incubation time minutes 25 1 60

Bind 1

5 Bind 1 Volume �L 410 200 500

6 Bind 1 Tipmixing minutes 15 1 20

7 Bind 1 Incubation time minutes 5 1 15

8 Bind 1 Settle time minutes 10 5 20

Wash
B39494AA2-12
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9 Wash Volume �L 800 500 1000

10 Wash Shake 1 speed on the Orbital 

Shaker

RPM 1300 800 1300

11 Wash Shake 1 time minutes 4 1 10

12 Wash Shake 2 speed on the Orbital 

Shaker

RPM 1000 800 1100

13 Wash Shake 2 time minutes 2 1 10

14 Wash Settle time minutes 8 5 15

Ethanol 1

15 Ethanol 1 Volume �L 750 500 1000

16 Ethanol 1 Shake speed RPM 1100 800 1200

17 Ethanol 1 Shake time minutes 2 1 5

18 Ethanol 1 Settle time minutes 3 1 10

19 Ethanol 1 Dry time minutes 5 1 15

DNase

17 DNase Solution Volume �L 100 20 150

19 DNase Shake speed on the Orbital 

Shaker

RPM 1000 800 1200

DNase Shake time minutes 2 1 5

20 DNase Sample Temperatureb �C 37 20 100

DNase Incubation time minutes 15 1 20

Rebind with Bind 2

21 Bind 2 Volume �L 200 100 500

22 Bind 2 Shake Speed on the Orbital 

Shaker

RPM 1000 800 1200

Bind 2 Shake time minutes 8 1 10

23 Bind 2 Incubate time minutes 5 1 10

24 Bind 2 Settle time minutes 5 1 10

Ethanol 2

25 Ethanol 2 Cycles time(s) 2 1 3

26 Ethanol 2 Volume �L 750 500 1000

27 Ethanol 2 Settle time minutes 4 1 5

28 Ethanol 2 Shake Speed on the Orbital 

Shaker

RPM 800 800 1200

29 Ethanol 2 Dry time minutes 5 0 10

Elution

30 Elution volume �L 40 20 100

Table 2.4  Procedure Default, Minimum and Maximum Values (Continued)

Step Step Description Units Default Minimum Maximum
B39494AA 2-13



Method Operation

Operating the RNAdvance Blood Method  
IMPORTANT Changing default protocol settings may cause undesirable results. Beckman Coulter’s 

warranty applies only for unchanged Default Protocol Settings.

To complete the Procedures Tab

1 On the Procedures Tab change or ensure that each variable is correct. Use the up and down 

arrow keys to select values. A value with a yellow background indicates that the value has 
changed from the default values.

NOTE To change the default values so that the variables here populate according to custom values, see 

Customer Default Settings on page 1-3.

2 Optional: To lock the values of the procedure, which prevents inadvertent changes to variables, 

click the Lock/Unlock Button . The Lock/Unlock screen displays.

Figure 2.8  Lock/Unlock Password

NOTE For first-time use, leave the first field, Enter Current Password, blank.

a. Enter a new password.

b. Re-enter the password.

31 Elution Shake speed on the Orbital 

Shaker

RPM 1000 800 1200

32 Elution Shake time minutes 2 1 15

33 Elution Incubation time minutes 1 0 5

34 Elution Settle time minutes 2 1 5

Transfer

35 Eluent Transfer volume �L 35 20 100

a.Set Lysis Sample Temperature to the desired Temperature in the well. See D Peltier Offsets in RNAdvance 

Blood Customer Default Values.

b.Set DNase Sample Temperature to the desired Sample Temperature in the well. See D Peltier Offsets 

in RNAdvance Blood Customer Default Values.

Table 2.4  Procedure Default, Minimum and Maximum Values (Continued)

Step Step Description Units Default Minimum Maximum
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c. Click OK. All variables become non-editable. To change locked values, click the 
Lock/Unlock Button and enter the password.

NOTE If a password is forgotten, contact Reagent Support at reagentsupport@beckman.com.

3 Optional: To reset all variables to the default values, click the 

Reset Default Values Button . All changed variables revert to default values.

Once the method begins running the software prompts you to set up reagents, tools and labware. 
See Table 2.5 for the sequence of this setup. Follow the prompts on the screen for actual values.

Figure 2.9  Instrument Setup

Running the RNAdvance Blood Method

IMPORTANT To ensure best possible outcomes, the RNAdvance Blood bottle containing Bind 1 must be 

shaken and mixed so that the beads are homogenous in solution. Run the procedure immediately 

following the placement and filling of RNAdvance Blood reagents. Failure to run the method immediately 

following the filling of reagents may cause the method to produce poor results.

After entering all protocol variables, positioning labware, and filling all reagent reservoirs, the 
RNAdvance Blood Method is ready to run.

To run the RNAdvance Blood Method

1 Confirm that all values in the user interface are correct for all RNAdvance Blood application 

variables. See Configuring the RNAdvance Blood Method.

2 From any of the user interface tabs, click the green run arrow .
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The Biomek instrument may appear to be idle at times, during which a timer appears. When this 
occurs an incubation time is being observed before the next step can be performed. See Figure 2.10.

Options for the timer include

 • Editing the timer duration to the precise number of hours, minutes and seconds.

 • Adding one minute to the elapsed time.

 • Expiring the timer immediately.

Table 2.5  Reagent and Deck Setup Guide

Step

Reagent/Tool/

Labware type

Labware 

Name Notes

Mix 

Reagents

DNase N/A Nuclease Free Water

DNase I buffer

DNase I

Use freshly prepared DNase I 

solution

Ethanol N/A Use freshly prepared 70% ethanol

Put Tools 

on the 

Deck

Gripper N/A N/A

MP1000 N/A N/A

Put 

Labware 

on the 

Deck

p1000 Barrier Tips ReagentTips

SampleTips_1

BloodTips

N/A

p200 Barrier Tips ElutionTips_1 N/A

96R Super Magnet 

Plate

Mag_1 N/A

p1000 Barrier Tips SampleTips_1 N/A

96-well plate ElutionPlate_1 N/A

Half Modular 

Reservoir

Res-Bind-

WashBuffer

Bind 1 in Section 1

Washbuffer in Section 2

AGCT_96RitterDeep

Square_GSL

PrepPlate1_1 Sample in selected columns 1-8

RNABlood_Mod_Res Res-LY-PK-DN-

RB-EL

Lysis in section 1

PK in section 2

DNase in section 3

Bind2 in section 4

Elute in section 5

Sections 6 and 7 are empty

IMReservoir96 Res-Ethanol Ethanol in section 1
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Figure 2.10  Editing or Expiring the Timer

When the method ends, the tips are unloaded and the Biomek Start arrow returns to green. 

Recovering from an Interrupted Method

There are several reasons a method may be interrupted:

 • Power failure

 • Tips did not load properly

 • Insufficient reagent

 • Instrument crash

The RNAdvance Blood Method provides ways to recover or restart the method efficiently:

 • Restart from the point where the method stopped.

 • Reset all steps for the plate.

 • Reset the deck: return all moveable labware to their starting positions.
B39494AA 2-17
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Recovery Tab

Figure 2.11  Recovery Tab

A. Recovery Tab

B. Plate Column

C. Reset Current Selection

D. Reset Current Plate

E. Set All Sections of Current Plate to 

Match Current Selection

F. Finished Tasks

G. Unfinished Tasks

H. Reset the Deck
B39494AA2-18
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To Recover the RNAdvance Blood Method

1 Address the source of the interruption.

2 Restart the RNAdvance Blood Method. The Recovery tab will be displayed. 

3 Confirm that the state of the deck on the Biomek 4000 matches the Deck Display. If the deck on 

the Biomek 4000 does NOT match the Deck Display, correct the deck on the Biomek 4000 to 
match it by dragging labware in the Deck Display.

4 Click any Tasks that show finished, but need to be recovered.

For example, if you can see that column eight does not have Bind 1 reagent, but the Recovery 
Tab shows that it was added, click that task in the Column 8 tab to make it an unfinished task. 

5 Click the Run button .

Table 2.6  Describing Recovery Tab

Screen Element Purpose Do this

A  Recovery Tab Allows you to see where the 

RNAdvance Blood Method was 

interrupted to more efficiently 

recover it.

Use this tab to reset the specific columns to be 

run again.

B  Plate Column Allows you to visualize the 

individual columns of the Plate.

Click the column tab to check the status of each 

column.

C  Reset Current 

Selection

Allows you to restart the current 

column to the beginning of the 

method.

Click this button to restart the selected column 

to the beginning of the method.

D  Reset Current 

Plate

.Allows you to restart the method 

from the beginning.

Click this button to restart the RNAdvance Blood 

method from the beginning.

E  Set All 

Sections of 

Current Plate to 

Match Current 

Selection

Allows you to set all active 

columns to the state of the 

currently selected column.

Click this button to set all active columns to start 

from the state of the currently selected column.

F  Finished 

Tasks

Cleared checkboxes show 

completed tasks by column.

To rerun a step for a column, check the 

appropriate checkbox.

G  Unfinished 

Tasks

Checked checkboxes show 

unfinished tasks. The green bar 

indicates the task next in line.

To skip a step for a column, clear (uncheck) the 

appropriate checkbox.

H  Reset the 

Deck

Moves all labware to the starting 

position.

Click this button to show how the deck should be 

reset.
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Abbreviations

µL — microliter

ALP — Automated Labware Positioner 

DNA — Deoxyribonucleic Acid 

GUI — Graphical User Interface

mL — milliliter

LIMS — Laboratory Information Management System

m — meter

RNA — Ribonucleic Acid

SPRI — Solid Phase Reverse Immobilization 

Vol — Volume
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Glossary

assay — procedure of repeat testing to determine the assigned value for a given lot and level of control.

beads — in SPRI technology, magnetic, uniform microparticles.

dead volume — in an automated system, the amount or volume of a sample or reagent that cannot be 

picked up by the pipette tip.

elution buffer — buffer which elutes DNA from magnetic particles.

ethanol wash —  washes the magnetic beads with 85% ethanol to remove contaminants.

gripper — a tool that includes mechanical fingers to grip labware. Gripper fingers grasp labware along 

the long side and move the labware from one location on the Biomek deck to another. The gripper 

contains two fingers: a double gripper located to the front and a single gripper located to the back of 

the tool.

PAXgene — Preservative and stabilizer for nucleic acids in whole blood.

reservoir — one-well labware receptacle holding liquid to be used in a method.

samples — PAXgene preserved human blood.

supernatant — a liquid lying above a solid residue after crystallization, precipitation, centrifugation, or 

other process.
B39494AA Glossary-1
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Index
A
ABGene 2800 plate, 1-2
abort button

description of screen element, 2-7
Agencourt

configuration of, 2-5
RNAdvancce protocol, 2-1
RNAdvance primary screen, 2-7, 2-12
SuperMagnet Plate, 1-2

ALPs
defined, Abbreviations-1

arrow
green, 2-15

assay
defined, Glossary-1

B
beads

defined, Glossary-1
Biomek

as instrument requirement, 1-1
occasionally idle, 2-16
timer, 2-16

boxes
of tips as instrument requirement, 1-2

C
columns tab

description of, 2-5
screen elements, 2-9

configuration
RNAdvance method, 2-5

configuring
system settings, 1-3

consumables, 1-2
customer default protocol settings, 2-2

D
dead volume

defined, Glossary-1
default protocol settings, 2-2
default values

description of screen element, 2-12
description

lock indicator, 2-7

E
elution buffer

defined, Glossary-1
ethanol wash

defined, Glossary-1

F
finished tasks

description of screen element, 2-19
forward button

description of screen element, 2-7

G
general settings, 1-3
green arrow, 2-5, 2-15
gripper

defined, Glossary-1
gripper tool, 1-1

as instrument requirement, 1-1

I
incubation

timing of, 2-16
input values

description of screen element, 2-7
instrument requirements, 1-1
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L
lock indicator

description of, 2-7
lock/unlock indicator

description of screen element, 2-12

M
magnet plates

as instrument requirement, 1-2
manual

conventions, xii
navigation tools and tips, xii

manual protocol, 2-1
method

changing appearance of structure, 2-2
configuration of, 2-5
running, 2-1

methods
causes of interruptions, 2-17
recovering, 2-17
ways to recover, 2-17

MP 200 tool, 1-1
as instrument requirement, 1-1

O
opening

project, 2-1
output

description of screen element, 2-7

P
plates

thermocycling, 1-2
procedure tab

description of, 2-5
screen elements, 2-11

procedure values
description of screen element, 2-12

project
opening, 2-1

protocol
default settings, 2-2
manual, 2-1

Q
quarter reservoir

as instrument requirement, 1-2
quick start tab

description of, 2-5
screen elements, 2-6

R
recovering method, 2-17
recovery tab

description of, 2-5
screen elements, 2-18

requirements
instrument, 1-1

reservoir
as instrument requirement, 1-2
defined, Glossary-1
quarter, 1-2

reservoir frame, 1-2
reset all plates

description of screen element, 2-19
reset deck

description of screen element, 2-19
reset this plate

description of screen element, 2-19
RNAdvance

primary screen definitions, 2-7, 2-12
run button

description of screen element, 2-7
running method, 2-1

S
screen elements

columns tab, 2-9
procedure tab, 2-11
quick start tab, 2-6
recovery tab, 2-18

settings
configuration, 1-3
default protocol, 2-2
general, 1-3

supernatant
defined, Glossary-1

system configuration, 1-3

T
thermocycling plate

as instrument requirement, 1-2
timer
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of Biomek, 2-16
tips

boxes of as instrument requirement, 1-2
unloading, 2-17

tool
gripper, 1-1
MP 200, 1-1
wash 8, 1-1

tracking
description of screen element, 2-7

trademarks, ii

U
unfinished tasks

description of screen element, 2-19

W
wash 8 tool, 1-1

as instrument requirement, 1-1
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Beckman Coulter, Inc.
Customer End User License Agreement

This Product contains software that is owned by Beckman Coulter, Inc. or its suppliers and is protected by 
United States and international copyright laws and international trade provisions. You must treat the 
software contained in this Product like any other copyrighted material. This license and your right to use the 
Product terminate automatically if you violate any part of this agreement.

This is a license agreement and not an agreement for sale. Beckman Coulter hereby licenses this Software to 
you under the following terms and conditions:

You May:

1. Use this software in the computer supplied to you by Beckman Coulter;
2. Maintain one copy of this software for backup purposes (the backup copy shall be supplied by 

Beckman Coulter);
3. After written notification to Beckman Coulter, transfer the entire Product to another person or entity, 

provided you retain no copies of the Product software and the transferee agrees to the terms of this 
license agreement.

You May Not:

1. Use, copy or transfer copies of this Software except as provided in this license agreement;
2. Alter, merge, modify or adapt this Software in any way including disassembling or decompiling;
3. Loan, rent, lease, or sublicense this Software or any copy.

Limited Warranty

Beckman Coulter warrants that the software will substantially conform to the published specifications for the 
Product in which it is contained, provided that it is used on the computer hardware and in the operating 
system environment for which it was designed. Should the media on which your software arrives prove 
defective, Beckman Coulter will replace said media free of charge within 90 days of delivery of the Product. 
This is your sole remedy for any breech of warranty for this software.

Except as specifically noted above, Beckman Coulter makes no warranty or representation, either expressed 
or implied, with respect to this software or its documentation including quality, performance, 
merchantability, or fitness for a particular purpose.

No Liability for Consequential Damages

In no event shall Beckman Coulter or its suppliers be liable for any damages whatsoever (including, without 
limitation, damages for loss of profits, business interruption, loss of information, or other pecuniary loss) 
arising out of the use of or inability to use the Beckman Coulter Product software. Because some states do not 
allow the exclusion or limitation of liability for consequential damages, the above limitation might not apply 
to you.

General

This agreement constitutes the entire agreement between you and Beckman Coulter and supersedes any 
prior agreement concerning this Product software. It shall not be modified except by written agreement 
dated subsequent to the date of this agreement signed by an authorized Beckman Coulter representative. 
Beckman Coulter is not bound by any provision of any purchase order, receipt, acceptance, confirmation, 
correspondence, or otherwise, unless Beckman Coulter specifically agrees to the provision in writing. This 
agreement is governed by the laws of the State of Florida.



© 2013 Beckman Coulter, Inc.

All Rights Reserved
www.beckmancoulter.com
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